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Chapter 713

One-Sample Cure
Model Tests
Introduction
This module computes the sample size and power of the one-sample parametric cure model proposed by Wu
(2015). This technique is useful when working with survival data in phase II clinical trials when a substantial
portion of the subjects are cured of the disease or ailment and you are comparing the results of a new treatment to
a historical control.

Technical Details
One-Sample Cure Model Test Statistic
Following Wu (2015), suppose the failure time, T*, is assumed to be T* = v T + (1 - v) ∞, where v indicates
whether the subject will experience failure and T denotes failure time of the subjects not cured. Let S(t) be the
latency distribution of T which in this procedure is assumed to be the Weibull distribution with shape parameter k
known and scale parameter λ. The survival distribution of T* is a mixture of a cure rate π = P(v = 0) and S(t)
given by
𝑆𝑆 ∗ (𝑡𝑡) = 𝜋𝜋 + (1 − 𝜋𝜋)𝑆𝑆(𝑡𝑡)

Suppose N subjects are enrolled in a study during the accrual period of length ta and then observed during a
follow-up period of length tf. Let ti and Ci denote the failure time and censoring time of the ith subject. The
observed failure time is Xi = T*i ^ Ci and the observed failure indicator is Δi = I(T*i ≤ Ci). The test L is defined in
terms of the number of observed failures O and the number of expected events E, as follows
𝐿𝐿 =

𝑂𝑂 − 𝐸𝐸

�(𝑂𝑂 + 𝐸𝐸)/2

The test statistic L is asymptotically standard normal distributed under the null, where
𝑛𝑛

𝑂𝑂 = � ∆i
𝑛𝑛

𝑖𝑖=1

𝐸𝐸 = � Λ∗0 (𝑋𝑋𝑖𝑖 )

Λ∗0 (𝑡𝑡)

𝑖𝑖=1

= − ln S0∗ (𝑡𝑡)

Note that Λ∗0 (𝑡𝑡) is the cumulative hazard function of S0∗ (𝑡𝑡) under the null hypothesis.
713-1
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

One-Sample Cure Model Tests

Statistical Hypothesis
The null hypothesis is
𝐻𝐻0 : 𝜋𝜋 = 𝜋𝜋0 and 𝜆𝜆 = 𝜆𝜆0

which is tested against one of the following three alternatives

𝐻𝐻1𝑎𝑎 : 𝜋𝜋 = 𝜋𝜋0 and 𝜆𝜆 = 𝜆𝜆1
𝐻𝐻1𝑏𝑏 : 𝜋𝜋 = 𝜋𝜋1 and 𝜆𝜆 = 𝜆𝜆0
𝐻𝐻1𝑐𝑐 : 𝜋𝜋 = 𝜋𝜋1 and 𝜆𝜆 = 𝜆𝜆1

Power Calculation

Wu (2015) gives the following power and sample size formulas for a one-sided hypothesis test based on L for the
Weibull distribution with known shape parameter k. The power of a two-sided test is found by substituting α/2 for
α. Note that we use the subscript 0 to represent the historic control and the subscript 1 to represent the new
treatment group.
𝜎𝜎�
𝜔𝜔√𝑛𝑛
𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 ≅ Φ �− 𝑧𝑧1−𝛼𝛼 −
�
𝜎𝜎
𝜎𝜎
𝑛𝑛 =

where
𝜔𝜔 = 𝑣𝑣1 − 𝑣𝑣0

(𝜎𝜎�𝑧𝑧1−𝛼𝛼 + 𝜎𝜎𝑧𝑧𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 )2
𝜔𝜔 2

𝜎𝜎� 2 = (𝑣𝑣1 + 𝑣𝑣0 )/2

𝜎𝜎 2 = 𝑣𝑣1 − 𝑣𝑣12 + 2𝑣𝑣00 − 𝑣𝑣02 − 2𝑣𝑣01 + 2𝑣𝑣0 𝑣𝑣1
𝜏𝜏

𝑣𝑣0 = � 𝐺𝐺(𝑡𝑡)𝑆𝑆1∗ (𝑡𝑡)ℎ0 (𝑡𝑡)𝑑𝑑𝑑𝑑
0

𝜏𝜏

𝑣𝑣1 = � 𝐺𝐺(𝑡𝑡)𝑆𝑆1∗ (𝑡𝑡)ℎ1 (𝑡𝑡)𝑑𝑑𝑑𝑑
0

𝜏𝜏

𝑣𝑣00 = � 𝐺𝐺(𝑡𝑡)𝑆𝑆1∗ (𝑡𝑡)ℎ0 (𝑡𝑡)𝜆𝜆∗0 (𝑡𝑡)𝑑𝑑𝑑𝑑
0

𝜏𝜏

𝑣𝑣01 = � 𝐺𝐺(𝑡𝑡)𝑆𝑆1∗ (𝑡𝑡)ℎ1 (𝑡𝑡)𝜆𝜆∗0 (𝑡𝑡)𝑑𝑑𝑑𝑑
0

𝜏𝜏 = 𝑡𝑡𝑎𝑎 + 𝑡𝑡𝑓𝑓

𝑆𝑆0∗ (𝑡𝑡) = 𝜋𝜋0 + (1 − 𝜋𝜋0 )𝑒𝑒𝑒𝑒𝑒𝑒(−𝜆𝜆0 𝑡𝑡 𝑘𝑘 )
𝑆𝑆1∗ (𝑡𝑡) = 𝜋𝜋1 + (1 − 𝜋𝜋1 )𝑒𝑒𝑒𝑒𝑒𝑒(−𝜆𝜆1 𝑡𝑡 𝑘𝑘 )

𝜆𝜆∗0 (𝑡𝑡) = −𝑙𝑙𝑙𝑙�𝑆𝑆0∗ (𝑡𝑡)�
ℎ0 (𝑡𝑡) = 𝜆𝜆0 𝑘𝑘𝑡𝑡 𝑘𝑘−1

ℎ1 (𝑡𝑡) = 𝜆𝜆1 𝑘𝑘𝑡𝑡 𝑘𝑘−1

(1 − 𝜋𝜋0 )𝑒𝑒𝑒𝑒𝑒𝑒(−𝜆𝜆0 𝑡𝑡 𝑘𝑘 )
𝜋𝜋0 + (1 − 𝜋𝜋0 )𝑒𝑒𝑒𝑒𝑒𝑒(−𝜆𝜆0 𝑡𝑡𝑘𝑘 )

(1 − 𝜋𝜋1 )𝑒𝑒𝑒𝑒𝑒𝑒(−𝜆𝜆1 𝑡𝑡 𝑘𝑘 )
𝜋𝜋1 + (1 − 𝜋𝜋1 )𝑒𝑒𝑒𝑒𝑒𝑒(−𝜆𝜆1 𝑡𝑡𝑘𝑘 )
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1
if 𝑡𝑡 ≤ 𝑡𝑡𝑓𝑓
𝜏𝜏 − 𝑡𝑡
𝐺𝐺(𝑡𝑡) =
if 𝑡𝑡𝑓𝑓 ≤ 𝑡𝑡 ≤ 𝜏𝜏
⎨ 𝑡𝑡𝑎𝑎
⎩ 0
otherwise
Note that ta represents the accrual time and tf represents the follow-up time.
⎧

The values of the v0, v1, v00, and v01 can be calculated by numeric integration.
The hazard rates λ0 and λ1 can be given in terms of the hazard ratio HR, the median survival times M0 and M1, or
the survival proportions S0 and S1 at time t0 of the latency distribution. These parameters are defined as
𝐻𝐻𝐻𝐻 = 𝜆𝜆1 /𝜆𝜆0
𝜆𝜆0 =
𝜆𝜆1 =

ln(2) − ln[𝑆𝑆0 ]
=
𝑡𝑡0𝑘𝑘
𝑀𝑀0𝑘𝑘

ln(2) − ln[𝑆𝑆1 ]
=
𝑡𝑡0𝑘𝑘
𝑀𝑀1𝑘𝑘

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with. This chapter covers
four procedures, each of which has different effect size options. However, many of the options are common to all
four procedures. These common options will be displayed first, followed by the various effect size options.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. The parameters that may be
selected are Power or Sample Size.
Select Sample Size when you want to calculate the sample size needed to achieve a given power and alpha level.
Select Power when you want to calculate the power.

Test
Alternative Hypothesis
Specify whether the statistical test is two-sided or one-sided.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of
equal survival curves when in fact the curves are different.
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Values must be between zero and one. Historically, the value of 0.80 was used for power of a phase II trial.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when you
reject the null hypothesis of equal survival curves when in fact the curves are equal.
Values of alpha must be between zero and one. Historically, the value of 0.05 has been used for a two-sided test
and 0.025 has been used for a one-sided test. You should pick a value for alpha that represents the risk of a type-I
error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size
N (Sample Size)
Enter a value for the sample size, N. This is the number of subjects in the study. You can enter one or more
positive integers greater than or equal to 3. You may also enter a range such as “10 to 100 by 10” or a list of
values separated by commas or blanks such as “20 40 60 80.”
Ta (Accrual Time)
Enter one or more values for the number of time periods (months, years, etc.) during which subjects are entered
into the study. The total duration of the study is equal to the Accrual Time plus the Follow-Up Time.
Accrual times can range from 0 to on up. Enter “0” when all subjects begin the study together.
Tf (Follow-Up Time)
The length of time between the entry of the last individual and the end of the study.

Effect Size
π0 (Proportion Cured – Control)
Specify the cure rate (proportion cured) in the historical control. Since this is a proportion, the value should be
from 0 to 1. You may enter a single value or a list of values.
Note that you must have either π0 and π1 different or λ0 and λ1 different’
π1 (Proportion Cured – New)
Specify the cure rate (proportion cured) in the new group. Since this is a proportion, the value should be from 0 to
1. You may enter a single value or a list of values.
Input Type
Specify which set of parameters you want to use to specify the hazard rates of the historical control (λ0) and the
new group from which the sample is drawn (λ1). These parameters are functionally related as shown above, so the
values of λ0 and λ1 are calculated from the items you enter (if necessary).
The possible choices are
•

Hazard Rates (λ0 and λ1)
Enter the values of the two hazards rates (λ0 and λ1) directly.

•

Hazard Rate and Ratio (λ0 and HR)
Enter the hazard rate of the historical control (λ0) and the hazard ratio HR = (λ1 / λ0).
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•

Median Survival Times (M0 and M1)
Enter the median survival times of the historical control (M0) and the new group (M1). The values of λ0 and λ1
are calculated based on the Weibull distribution as shown above.

•

Proportions Surviving (S0 and S1)
Enter the proportions surviving for a fixed period of time (T0) of the historical control (S0) and the new group
(S1). The values of λ0 and λ1 are calculated based on the Weibull distribution as shown above.

λ0 (Hazard Rate – Control)
Enter a value (or range of values) for the hazard rate (event rate or incidence rate) of the distribution of the
historical control. This distribution is assumed to be Weibull with a known shape parameter k.
This rate is compared to λ1 by the one-sample logrank test. The ratio of these rates, HR = λ1 / λ0, is the amount that
this design can detect.
The value must be greater than zero.
Example of Estimating λ0
If 200 control patients were followed for 1 year and 40 experienced the event of interest and there is no censoring,
the hazard rate would be
λ0 = 40/(200*1) = 0.2 per patient-year.
Note that this estimate does not consider the censoring. For censored survival data, it is often estimated from a
survival distribution fitted from historical data. For example,
𝜆𝜆0 = −

ln 𝑆𝑆(𝑡𝑡0 )
𝑡𝑡0𝑘𝑘

λ1 (Hazard Rate – New)
Enter a value (or range of values) for the hazard rate (event rate or incidence rate) of the distribution of the
response values in the new group. This distribution is assumed to be Weibull with a known shape parameter k.
This rate is compared to λ1 by the one-sample logrank test. The ratio of these rates, HR = λ1 / λ0, is the amount that
this design can detect.
The value must be greater than zero.
Example of Estimating λ1
Once we have λ0 and HR, λ1 is obtained as follows
𝜆𝜆1 = 𝐻𝐻𝐻𝐻(𝜆𝜆0 )

HR (Hazard Rate – New)
Enter one or more values for HR, the hazard ratio λ1 / λ0. This value is used with λ0 to calculate a value for λ1.
HR can be any number greater than zero and unequal to one. You may enter a single value or a range of values.
M0 (Median Survival - Control)
Specify a single value, or set of values, for the median survival time in the historical control group. Assuming a
Weibull distribution with shape parameter k, the value of λ0 is calculated as given in the technical details above.
This value must be a number greater than zero.
M1 (Median Survival - New)
Specify a single value, or set of values, for the median survival time in the new (treatment) group. Assuming a
Weibull distribution with shape parameter k, the value of λ1 is calculated as given in the technical details above.
This value must be a number greater than zero.
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S0 (Proportion Surviving - Control)
Enter the proportion surviving (S0) for a fixed period of time (t0) in the historical control group. The value of λ0 is
calculated as given in the technical details above.
Since this is a proportion, it must be a value between (but not including) zero and one. You may enter a single
value or a range of values.
S1 (Median Survival - New)
Specify a single value, or set of values, for the median survival time in the new (treatment) group. Assuming a
Weibull distribution with shape parameter k, the value of λ1 is calculated as given in the technical details above.
This value must be a number greater than zero.
T0 (Time of S0 and S1)
When S0 and S1 are selected as the Input Type, this value is needed to give the amount of time that S0 and S1 are
related to. Since this value is a time period, it must be a positive value.
k (Weibull Shape Parameter)
This is the (assumed to be known) value of Weibull shape parameter. Usually, you will need to estimate k from
the historical controls. If you don’t have any information, you can set k to one which results in the exponential
distribution.
The parameter k must be a number greater than zero. Usually it is greater than zero and less than or equal to 5.
Examples
The shape of the Weibull distribution probability distribution function is quite different depending on the value of
k. Here are some examples. Note that elapsed time is shown on the horizontal axis.
k = 0.5
|•
|•
|•
| •
|
• •
•
+---------------------k = 1 (Exponential)
|•
| •
|
•
|
•
|
•
•
+---------------------k=2
| •
| • •
|•
•
|•
•
|•
•
+---------------------k = 5 (approx. normal)
|
•
|
• •
|
•
•
| •
•
|•
•
+-------------------------
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Example 1 – Finding the Sample Size
A researcher is planning a clinical trial to compare the response of a new treatment to that of the current
treatment. The median survival time in the current population is 1.54 and the cure rate is 0.32. Failures in the
current population exhibits a Weibull distribution with a shape parameter of 1.67. The researcher wants a sample
size large enough to detect hazard ratios of 0.7, 0.75, and 0.8 at a 5% significance level for a two-sided test. They
assume that the cure rate stays the same. The accrual period will be 3 years. The follow-up period will be 1 year.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the One-Sample Cure Model Tests procedure window by expanding Survival, then One Survival
Curve, and then clicking on One-Sample Cure Model Tests. You may then make the appropriate entries as
listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

Option

Value

Design Tab
Solve For ................................................ Sample Size
Alternative Hypothesis ............................ Two-Sided
Power ...................................................... 0.90
Alpha ....................................................... 0.05
Ta (Accrual Time) ................................... 3
Tf (Follow-Up Time) ................................ 1
π0 (Proportion Cured – Control) ............. 0.32
π1 (Proportion Cured – New) ................. 0.32
Input Type ............................................... M0, HR (Median Survival, Hazard Ratio)
M0 (Median Survival – Control) .............. 1.54
HR (Hazard Ratio) .................................. 0.7 0.75 0.8
k (Weibull Shape Parameter) ................. 1.67

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for the Two-Sided, One-Sample Cure Model Test

Power
0.9006
0.9000
0.9001

N
370
576
972

Evnt
Cnt
E
157
253
441

Accr
Time
Ta
3.0
3.0
3.0

Folw
Up
Time
Tf
1.0
1.0
1.0

Cntl
Cure
Rate
π0
0.32
0.32
0.32

New
Cure
Rate
π1
0.32
0.32
0.32

λ1/λ0
Haz
Ratio
HR
0.700
0.750
0.800

Cntl
Med
Surv
M0
1.54
1.54
1.54

New
Med
Surv
M1
1.91
1.83
1.76

Weibull
Shape
k
1.67
1.67
1.67

Alpha
0.050
0.050
0.050

References
Wu, Jianrong. 2015. 'Single-arm phase II trial design under parametric cure models', Pharmaceutical
Statistics, wileyonlinelibrary.com, DOI: 10.1002/pst.1678.
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Report Definitions
Power is the probability of rejecting a false null hypothesis.
N is the sample size of the New group, assuming no subject lost to dropout or follow-up during the study.
E is the expected number of events (failures) in the new group during the study.
Ta is the length of the accrual time during which subjects are added to the study. Subjects are added
uniformly.
Tf is the length of the follow-up time after the last subject is added to the study.
π0 is the cure rate of the historic control group.
π1 is the anticipated cure rate of the new group. The difference between π1 and π0 may be one of the
statistics that you want to test.
HR is the hazard ratio (λ1/λ0) is the new group's hazard rate divided by the hazard rate of the historic
control.
M0 is the median survival time of the historic control group.
M1 is the median survival time of the new (treatment) group.
k is the shape parameter of the Weibull distribution used for both groups.
Alpha is the probability of rejecting a true null hypothesis.
Summary Statements
A two-sided, one-sample cure model test calculated from a sample of 370 subjects achieves 90.1%
power at a 0.050 significance level to detect a cure rate of 0.320 in the new group when the
cure rate in the historic control group is 0.320 and/or detect a hazard ratio of 0.700 when the
median survival time of the historic control group is 1.54. Subjects are accrued for a period
of 3.0. Follow-up continues for a period of 1.0 after the last subject is added. The expected
number of events during the study is 157. It is assumed that the survival time distributions of
both groups are approximated reasonable well by the Weibull distribution with a shape parameter
of 1.67.

This report presents the calculated sample sizes for each scenario as well as the values of the other parameters.

Plots Section

This plot shows the relationship between sample size and HR.

713-8
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

One-Sample Cure Model Tests

Example 2 – Validation using Wu (2015)
Wu (2015) gives an example in which the power if 0.80, alpha = 0.05 for a one-sided test, k = 1.018, Ta = 3 and
Tf = 1, λ0 = 0.836, HR = 1/1.75 = 0.57143, and π0 = 0.35. Wu calculates N to be 93.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the One-Sample Cure Model Tests procedure window by expanding Survival, then One Survival
Curve, and then clicking on One-Sample Cure Model Tests. You may then make the appropriate entries as
listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

Option

Value

Design Tab
Solve For ................................................ Sample Size
Alternative Hypothesis ............................ One-Sided
Power ...................................................... 0.80
Alpha ....................................................... 0.05
Ta (Accrual Time) ................................... 3
Tf (Follow-Up Time) ................................ 1
π0 (Proportion Cured – Control) ............. 0.35
π1 (Proportion Cured – New) ................. 0.35
Input Type ............................................... λ0, HR (Hazard Rate, Hazard Ratio)
λ0 (Hazard Rate – Control) .................... 0.836
HR (Hazard Ratio) .................................. 0.57143
k (Weibull Shape Parameter) ................. 1.018

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for the Two-Sided, One-Sample Cure Model Test

Power
0.8022

N
93

Evnt
Cnt
E
41

Accr
Time
Ta
3.0

Folw
Up
Time
Tf
1.0

Cntl
Cure
Rate
π0
0.35

New
Cure
Rate
π1
0.35

λ1/λ0
Haz
Ratio
HR
0.571

Cntl
Haz
Rate
λ0
0.836

New
Haz
Rate
λ1
0.478

Weibull
Shape
k
1.02

Alpha
0.050

PASS has also calculated N as 93.
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